Aboutthe Tutorial

Microsoft PowerPoint is a commercial presentation application written and distributed by
Microsoft for Microsoft Windows and Mac OS X. The current versions at the time of writing
this tutorial are 2010 for Microsoft Windows and 2011 for Mac OS X.

Microsoft PowerPoint is a presentation tool that supports text, shapes, graphics, pictures
and multimedia along with integration with other Microsoft Office products like Excel.

By default, documents saved in PowerPoint 2010 are saved with the .pptx extension
whereas, the file extension of the prior PowerPoint versions is .ppt.

Prerequisites

Before proceeding with this tutorial you should have a basic understanding of Computer
peripherals like mouse, keyboard, monitor, screen, etc. and their basic operations .



Table of Contents

10.

11.

12.

13.

14.

15.

16.

17.

FiY o TN A A L=l LV o T T | PP PPORPPPPRTPPPPPN i
F X0 Te 117 Vo P TP PR PPPPRTPTPPPR i
Pr O B OUISIEES 1 eeeteerriritiiiti i ieessie e e e e e e e e ettt ettt e et e e e e e aaatbaaa s saassaeeeeeeeeaaeeeaeeeeseeessssssssnsssnssassaesseaeeeeeeeeeeeesssenssnnnnnnn i
(O00] 0}V T=d a AR T DT [ =] 1o 1] U i
RISl e) f @0 14721 PP PP UPPPP ii
PowerPoint 2010 — Getting Started .............cccooiiiiiiii i 1
PowerPoint 2010 — EXPlOring WINAOWS................uuiiiiiiiiiii it e e e e e e e e s e e e e e aaeeeeaaan 4
PowerPoint 2010 - BaCKStAgE VIEW ....cccceiiiiiiiiiiirisnneeeteiiiessiissssssssnnseesessssssssssssssssnnsssssessssssssssssnnnnsssssssssssens 8
ACCESSING BACKSTAZE VIEW ...vvviiieeieiee i e ittt e e e e e e e ettt e e e e e e e e s ettt aaeeeeeeaeaeeeasssssstaseaeeeaeeeseesannssrssanneaeas 8
Organization Of BACKSTAZE VIEW..........uuuiiiiiiiieie ettt e e e e e e e ettt e e e e e e e e e e e ee e asaabaaseeaaaaeeeeeesansssssaaaaaeas 9
PowerPoint 2010 — Creating Presentation ..........cccceecveeeiiiiiieeiiinineieiniiiennissnnsssssseessssssssssssssssessssssnnnns 11
PowerPoint 2010 — Adding NE@W SIA@S ............cciiiiiiiiiiii e e e e e e 13
PowerPoint 2010 — Adding TEXE N BOXES ............uuuiiiiiiieeiiiiiiiiiiiirr e e e e e e e s s s e e e e e e e e e s s s s e nrnb e e reeaaeaeaaas 17
PowerPoint 2010 — Adding NEeW TEXE BOXES ..........ccciiuiiiiiiiiiiiieeiiiiitee sttt e e sttt e et e e e s snb e e e st bee e e s annnes 20
PowerPoint 2010 — Deleting EXisting Slide...............cooooi i 24
PowerPoint 2010 — Rearranging Sldes ..............ccuuiiiiiiiiiiiiii e 28
INOFMIAT VIBW ..ttt ettt ettt e e e e e e s ettt e et e e eeeesaas bbbt bbb eeeeeeeeesessaasnsbbbeaeeeaaeesssnnnnnnnnes 29
SlIAE SOTEEI VIBW ..ttt e ettt e e e e e s s st ettt e e e e e e e e s s s s sabbbbbaeeeaeeeesessaasnsraaaaaaeeaaeens 31
PowerPoint 2010 — Adding Slide NOtES........cccceriiiieiiiiisiiiiiicir it ass e 33
PowerPoint 2010 — Managing SECLIONS ......cceviiiiiiiiiiiiiiinsnneeeniiiiiiiiiisssesseriiiiiisiisssssssssttieesssssssssssssnsss 38
(@10 L] =Y =T A o] o PP TUPPPPRPPPIN 38
REAITANGING SECTIONS. ...ttt et e e e s s st e e e e e e e e e e s s s bbb ee et e eeeeeseesannnnnns 45
1] =l AT g Y Y=o u o] o LSRR 48
PowerPoint 2010 — Working With OUtliNeS ................cooiiiiiiiii e 49
POWErPOINt 2010 — STAEDAIS ..ot e e 52
PowerPoint 2010 — Presentation VIEWS............ocoiiiiiiiiiiiiiiiiiee ettt e e e s b aee e 56
NOFIMAT VIBW ettt ettt e sttt e e s abte e e e s ab bt e e e s aabbeeeeeaabbbeessaabbeeeeenabbaeeesaanbeeeesaanraeeens 57
SIIIE SOTEEI VIBW ..ttt ettt ettt e e sttt et e e st b e e e s aabbe e e e eabbaeessasabteeeeaasbaaeesanseeeesnnsbnaeessnnes 58
REATING VIBW ...eeiieieeiie ettt ettt e e e e e sttt et e e e e e e e e ese e eeeteaaaeaeaaeeesssasnsssaaaaeeeaeaaeeaasaassssssanneeaaeeeseennnnnnns 59
STABSNOW ettt ettt e s sttt e e s sttt e e s e b b beee s saabbaeessaabbeeeesaabbaeeeeaabbteeesanbeeeeeaan 60
PowerPoint 2010 — Setting Back8roUNdS ................coiiiiiiiiiiiiiiiiie et 61
PowerPoint 2010 — Slide OrieNntatioNs.............cooiiiiiiiiiiiiiie e s s a e e 67

PowerPoint 2010 — Saving Presentation..............coouiiiiiiiiiiii e 68



18. PowerPoint 2010 — Reviewing Presentation ...............cciiiiiiiiii i 72
19. PowerPoint 2010 — Adding Slide NUMDBEIS .............coooiiiiiiiiii e 74
20. PowerPoint 2010 — Adding Header & FOOTEr .............coooiuiiiiiiiiiiiii et 78
21. PowerPoint 2010 — RUNNING SIIAESROW ............cooiiiiiiiiii e 82
22, PowerPoint 2010 — Keyboard SROrtCULS ..............ccuiiiiiiiiiiii e 84
23. PowerPoint 2010 — Getting Context Help............cccoiiiiiiiiiiii e 87
EDITING PRESENTATION L. ittt e e e e et e e e e e e e e e b eeaeeees &9
24. PowerPoint 2010 — Copy & Paste CONTENt........cciiiiiriiiiiienunnnisiiiiiiiiiiiiiiiiiininnrnsssssssssssssssssssssssssssssssssssnnnns 920
25. PowerPoint 2010 — Find & Replace CONTENt .............cooiiiiiiiiiiiiiiiie et 93

FINAING CONTENTE ....eeiiiiiiiiie ettt e sttt e e ettt e e s sttt e e e eabbb e e e s saabeeeeeenbeeeessanneeeeesnanraeens 93

2T o] =Tl T 0T g1 =Y o | PSRRI 95
26. PowerPoint 2010 — Undo Edited Changes .............c..cooiiiiiiiiiiiiiiiic it e e 97
27. PowerPoint 2010 — SPeII CRECK .........uiiiiiiiii e e e e e e e e e 100
28. PowerPoint 2010 — Content Translation..............ccoooiiiiiiiii e 105
29. PowerPoint 2010 — Setting LangUABe TYPE.......cooiuuriiiiiiiiiiie ittt e e sttt e e s sbe e e e e e snbeeeenns 108
30. PowerPoint 2010 — Duplicating CoNteNt.............cccviiiiiiiiiiii i 113

CUL-PaSTE PrOCEAUNE ...ttt ettt s e e st e st e sen et e ser e e eseneeenneesaneeens 113

COPY-PaSTE PrOCEAUIE ...t ettt ettt e ettt e e s ettt e e s ettt e e s e aabteeeseasbbeeesennbeeeeseanbeeeessnnseeeenns 116
31. PowerPoint 2010 — SPecial Characters ..............oocuuiiiiiiiiiie et e e 118
32, PowerPoint 2010 — Slides ZoOM IN-OUL .....cccceeiiiieiiiiiiiiieiinneiineeicneeineiieeieseeiesseiestesstessstssssesnsne 122
FORMATTING PRESENTATION ....uuiiiiiieee e 125
33. PowerPoint 2010 — FONt ManagemeNnt . ..........cccooiuiiiiiiiiiiie ettt e st e e b e e 126
34. PowerPoint 2010 — Setting TeXE FONTS............ooiiiiiiiiiiiiiie e 129
35. PowerPoint 2010 — TeXt DECOTAtION .........cooiiiiiiiiiiieieree ettt 133
36. PowerPoint 2010 — Changing TeXt CaSE..........ccoiuieiiiieriiieeiiieertee et e e st e e seteeesat e e st e e st e e snbeeanneeeaeeeesneees 137
37. PowerPoint 2010 — Changing TeXt SIZ..........c.coiiuiiiiiieiiie ettt ettt e s e rae e e eeeeeneeas 140
38. PowerPoint 2010 — Changing TeXt COION ...........ccouiiiiiiiiiiiii it 144
39. PowerPoint 2010 — TeXt AINMENTS ..............ovviiiiiiiii e e e e e s s r e e e e e e e e e e e aaans 149



40. PowerPoint 2010 — INdent Paragraphs ..............oooiiiiiiiiiiiiiicie e 151
41. PowerPoint 2010 — Setting Line SPACING ...........ocoiiiiiiiiiiiiiiie e 154
42, PowerPoint 2010 — Borders and Shades.................ouiiiiiiiiiiiiii e 157
APPIYING BOIUEIS ...ttt e e e ettt s aaeeeeeeeeaaaaaaeeeaeeesstaa st basen i aaaessaaaaaaaaaaneens 157
APPIYING SRATES ...ttt e et e e st e e e e e e e e bt e e e e nbn e e e s e et e e e e nreeas 160
43. PowerPoint 2010 — AppPly FOrmMatting............ccviiiiiiiiiiiiiiiic e 163
44, PowerPoint 2010 — USINg SIide IMASEEI ...........uviiiiiiiiiii it 167
45. PowerPoint 2010 — Saving Design TempPlate ............cccoooiiiiiiiiiiiii e 172
WORKING WITH MULTIMEDIA ..o 177
46. PowerPoint 2010 — Adding Pictures t0 SIde ..............cccooiiiiiiiiiiiiiiii e 178
47. PowerPoint 2010 — Editing Added Pictures..................uuiiiiiiiiiiiii e 183
IMAEE AQJUSTIMENTS ..eiiiiiiiiicciiieeee et e e e e e e e st e e e e e e e e e e s s aee et eaeeeeeeaeeeesaaansssanaaaaaaaaaessssansssssnenaeaeeseeannnnns 184
PICTUIE SEYIES ettt ettt e e et e e e sttt e e e bt e e s s abt e e e e e nbb e e e e e bt e e e e sannreeas 184
48. PowerPoint 2010 — Formatting Added PiCtUres..............cccviiiiiiiiiiiiiii e 185
Picture ArrangemeENnt FEAtUIES ......ceiiiiiiiiiiiiiiiiiiiiiiersee s e e e e e e e e e et e e ettt e et eae bt baaaba s s s e e seeeseaaeaeeseeeseessssnnnnes 186
PICEUIE SIZING FEATUIES ...vuiiiiiiiee e et re e s e e e e e e e e e e et e e et e e et e e et taaa bt ssaassaeeeeaaeaeeseeeseenneensrnen 187
49, PowerPoint 2010 — Inserting @ SCre@NShOt ..............cuuiiiiiiiiiiii e 188
50. PowerPoint 2010 — Adding Shapes to SIIde .............cooiiiiiiiiiii e 192
51. PowerPoint 2010 — Editing Added Shapes ...............ccoiiiiiiiiiiiiii e 195
INSEIT SNAPE FEATUIES.....ciieeiieeeeeeee e e e e et e e e e e e e e e e et e e e e e eeeeeessnnsssaaaeaeaeeaeesssaannnssseeneeaaeeeeanannns 196
SNAPE STYIES FEATUIES. .. eeeiiiieeee et e e e e e e e e e e e s st e e e eeeeeeesasnssteaaaeeeeaeeeesasannssernnneeaeens 196
52. PowerPoint 2010 — Formatting Added Shapes ...............ccciiiiiiiiiiiiii e 197
Shape ArrangEMENT FEATUIES .......cc.euiiiiiiieeee e e eeeeeccitt e e e e e e e e e e ettt b e e e e eeaeaeeeesaatbttsaseeeeaeeeeeaaansssssaraaaaaeas 198
SNAPE SIZING FEATUIES ... euiiiiiiie e i e e ettt e e e e e e ee ettt e e e e e e e e e e s esetbabbaeeeaeaaaaeeaaaasssrtsasseaeaaeesseaansssssaaaaaaanas 198
53. PowerPoint 2010 — Adding TeXt t0 SNAPES ..........ooviiiiiiiiieiiie et 199
54. PowerPoint 2010 — Arranging Shapes/IMages .............cccveeiiuiiiiii ittt vee s 201
55. PowerPoint 2010 — Grouping/Ungrouping OBJECES .............cccoiiviiiiiiiciiiie ittt 207
56. PowerPoint 2010 — Adding AUdio & V@O ...........ccceeiiiiiiiiiiiiiiiiccc e s e e e e e e e e 214
57. PowerPoint 2010 — Adding & Formatting Tables ... 221
TablE DESIZN FEATUIES ...ttt e e e e e ettt e e e e e e e e e e e ettt b b e e e e eeeeeeeeeeasssaaaaaaaaaaeeesssassstasseseaaeaeeaeaannns 226
TabIE FOIMAt FEATUIES ...viiiiiiiiieeiiiiitte e ettt ee e e sttt e e et e e e s sttt e e e s sabte e e e saabaeeeessbbaeessaabaeeeesnssaaeessnsssaeessnnsseeas 229
58. PowerPoint 2010 — Adding & Formatting Charts ................ccccciiiiiiiii e 233



Chart DESIGN FEATUIES ......uueeiieeeiietee ettt ettt ettt e ettt e e ettt e e s e bbbt e e e easbb e e e s enbbeeessanbaeeeseanneeeenas 237

Chart LAYOUL FEAUIES .......eeeiiieeeieeee ettt ettt e ettt e e e ettt e e s e bbbt e e s eab bt e e e sanbneeeeeanneeeenas 239

Chart FOIM@t FEATUIES ......eeiiieiiieeee ettt ettt ettt e e ettt e e s sttt e e e e bbbt e e s enbbeeeseanbneeeseanneeeenas 242
59. PowerPoint 2010 — Adding & Formatting SmartArt.............cccciiiiiiiiii e 245

SMArtAIrt DESIGN FEATUIES....ciiiiiiiiiiiiee e e e e e s s rrreaeeeeeee s 249

SMArTArt FOrMAt FEATUIES ....eevieeiiie e e e e e eeeee 252
60. PowerPoint 2010 — Adding & Previewing ANIMatioNns .......ccccceceeeiiiiscnniiiisnnneniissssnenssssssesssssssnssssssssnsassas 255
61. PowerPoint 2010 — Adding & Previewing Transitions............ccccccoviiiiiiiiiiiiiiii e 261
SHARING PRESENTATION ...t 265
62. PowerPoint 2010 — Creating @ PDF File ..........cocoiiiiiiiii e 266
63. PowerPoint 2010 — Creating @ Video File ............cc.oiiiiiiiiiii e 270
64. PowerPoint 2010 — Creating an IMaAge File ........cccvveeiiiiiiiniiiiinnneniiininnniiisnsesiissssenisssssessssssssssssssssssess 275
65. PowerPoint 2010 — Printing Presentation ...............cccooiiiiiiiiiiiiio e 279
66. PowerPoint 2010 — Broadcasting SIIAeShOW .............c.ocuviiiiiiiiiii e 281
67. PowerPoint 2010 — Packaging Presentation .............cccocuuiiiiiiiiiiioniiie e 285
68. PowerPoint 2010 — Setting DOcUMENTt PasSWOKd .............cooiiiiiiieiiiiiiii et iiee s e s siree s sareee e 288
69. PowerPoint 2010 — EMailing SHA@ShOW...............cccoiiiiiiiiiiii s 292



1. PowerPoint 2010 — Getting Started

In this chapter, we will understand how to get started with PowerPoint 2010. We will
understand how to start PowerPoint 2010 application in simple steps. To access PowerPoint
2010, you must have Microsoft Office 2010 installed in your PC. Only Office 2010 Home
and Student, Home and Business, Standard, Professional and Professional Plus packages
have PowerPoint included in them. Other packages may have a viewer, but you cannot
create presentations with them.

Step 1: Click the Start button.
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Step 2: Click All Programs option from the menu.

All Programs

Step 3: Search for Microsoft Office from the sub menu and click it.

Microsoft Office



Step 4: Search for Microsoft PowerPoint 2010 from the submenu and click it.

Microsoft PowerPoint 2010

This will launch the Microsoft PowerPoint 2010 application and you will see the following
presentation window.
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2. PowerPoint 2010 — Exploring Windows

The following screenshot shows the various areas in a standard PowerPoint file. It is

important to familiarize yourself with these areas as it makes learning and using
PowerPoint easier.
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File Tab

This tab opens the Backstage view which basically allows you to manage the file and
settings in PowerPoint. You can save presentations, open existing ones and create new
presentations based on blank or predefined templates. The other file related operations
can also be executed from this view.
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The ribbon contains three components:

e Tabs: They appear across the top of the Ribbon and contain groups of related
commands. Home, Insert, Page Layout are examples of ribbon tabs.

¢ Groups: They organize related commands; each group name appears below the
group on the Ribbon. For example, a group of commands related to fonts or a group
of commands related to alignment, etc.

¢ Commands: Commands appear within each group as mentioned above.

Title Bar

This is the top section of the window. It shows the name of the file followed by the name
of the program which in this case is Microsoft PowerPoint.

Slide Area

This is the area where the actual slide is created and edited. You can add, edit and delete
text, images, shapes and multimedia in this section.



Help

The Help Icon can be used to get PowerPoint related help anytime you need. Clicking on
the "?" opens the PowerPoint Help window where you have a list of common topics to
browse from. You can also search for specific topics from the search bar at the top.
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The zoom control lets you zoom in for a closer look at your text. The zoom control consists
of a slider that you can slide left or right to zoom in or out, you can click on the - and +
buttons to increase or decrease the zoom factor. The maximum zoom supported by
PowerPoint is 400% and the 100% is indicated by the mark in the middle.



Slide Views

The group of four buttons located to the left of the Zoom control, near the bottom of the
screen, lets you switch between PowerPoint views.

¢ Normal Layout view: This displays page in normal view with the slide on the right
and a list of thumbnails to the left. This view allows you to edit individual slides and
also rearrange them.

o Slide Sorter view: This displays all the slides as a matrix. This view only allows
you to rearrange the slides but not edit the contents of each slide.

¢ Reading View: This view is like a slideshow with access to the Windows task bar
in case you need to switch windows. However, like the slideshow you cannot edit
anything in this view.

Notes Section

This sections allows you to add notes for the presentation. These notes will not be
displayed on the screen during the presentation; these are just quick reference for the
presenter.

Quick Access Toolbar

The Quick Access Toolbar is located just under the ribbon. This toolbar offers a convenient
place to group the most commonly used commands in PowerPoint. You can customize this
toolbar to suit your needs.

Slide Tab

This section is available only in the Normal view. It displays all the slides in sequence. You
can add, delete and reorder slides from this section.



3. PowerPoint 2010 - Backstage View

In Office 2010, Microsoft replaced the traditional file menu with the new Backstage view.
This view not only offers all the menu items under the file menu, but additional details
which makes management of your files a lot easier.

Accessing Backstage View

You can access the Backstage view simply by clicking on the File tab. You can exit this
view by clicking on any tab (including the File tab again). You can also press the 'Esc’
button on the keyboard.
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Organization of Backstage View

The backstage view has three sections or panes.
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¢ First Pane: This is the commands pane which consists of all the commands you would
typically find in the file menu of older versions. You also have the Options menu which
lets you edit the options on the program like customizing the ribbon.

Various commands under the first pane are described in the table below:

Command Description

Save This allows you to save a new file or an existing file in
standard format. If you are working on a previously saved
file this will save the new changes in the same file format. If




you are working on a new file, this command would be similar
to the Save As command.

Save As Allows you to specify the file name and the file type before
saving the file.
Open Allows you to open new PowerPoint files.
Close Allows you to close an existing file.
Info Displays the information about the current file.
Recent Lists series of recently viewed or edited PowerPoint files.
New Allows you to create a new file using blank or pre-defined
templates.
Print Allows you to select the printer settings and print the
presentation.
Save & Send Allows you to share your presentation with larger audience
via emails, web, cloud services, etc.
Help Provides access to PowerPoint Help.
Options Allows you to set various options related to PowerPoint
program.
Exit Closes the presentation and exits the program.

Second Pane: This is the subcommands pane. This will list all the commands
related to the main command you choose in the first pane. For example, if you
select Print in the first pane, you get to choose the printer and adjust the print
settings in the second pane.

Third Pane: This is the preview or file information page. Depending on the
command and the subcommand you select, this pane will either display the
properties of the file or give you a preview of the file.




4. PowerPoint 2010 — Creating Presentation

PowerPoint offers a host of tools that will aid you in creating a presentation. These tools
are organized logically into various ribbons in PowerPoint. The table below describes the
various commands you can access from the different menus.

Menu Categories Ribbon Commands
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PowerPoint 2010

Menu Category Ribbon Commands

Home Clipboard functions, manipulating slides, fonts, paragraph
settings, drawing objects and editing functions

Insert Insert tables, pictures, images, shapes, charts, special texts,
multimedia and symbols

Design Slide setup, slide orientation, presentation themes and
background
Transitions Commands related to slide transitions
Animations Commands related to animation within the individual slides
Slideshow Commands related to slideshow set up and previews
Review Proofing content, language selection, comments and comparing

presentations

View Commands related to presentation views, Master slides, color
settings and window arrangements

Besides these depending on the objects selected in the slide, there are other menu tabs
that get enabled.



5. PowerPoint 2010 — Adding New Slides

In this chapter, we will understand how to add new slides in an existing presentation. Here
are the steps that allow you to insert a new slide in the deck:

Step 1: Right-click in the Navigation Pane under any existing slide and click on the New

Slide option.
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Step 2: The new slide is inserted. You can now change the layout of this slide to suit your
design requirements.

New Slide Inserted
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Step 3: To change the slide layout, right-click on the newly inserted slide and go to the
Layout option where you can choose from the existing layout styles available to you.



Layout Menu Option

Slide Layout Styles
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You can follow the same steps to insert a new slide in between existing slides or at the
end on the slide list.

When we insert a new slide, it inherits the layout of its previous slide with one exception.
If you are inserting a new slide after the first slide (Title slide), the subsequent slide will
have the Title and Content layout.

You will also notice that if you right-click in the first step without selecting any slide the
menu options you get are different, although you can insert a new slide from this menu
too.
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6. PowerPoint 2010 — Adding Text in Boxes

PowerPoint allows users to add text to the slide in a well-defined manner to ensure the
content is well distributed and easy to read. The procedure to add the text in a PowerPoint
slide is always the same - just click in the text box and start typing. The text will follow
the default formatting set for the text box, although this formatting can be changed later
as required. What changes is the different kinds of content boxes that support text in a
PowerPoint slide.

Given below are some of the most common content blocks you will see in PowerPoint.

Title Box

This is typically found on slides with the title layout and in all the slides that have a title
box in them. This box is indicated by "Click to add title".

Title Box

Subtitle Box




Subtitle Box

This is found only in slides with the Title layout. This is indicated by "Click to add
subtitle".

Content Box

This is found in most of the slides that have a placeholder for adding content. This is
indicated by "Click to add text". As you can see, this box allows you to add text as well
as non-text content. To add text to such a box, click anywhere on the box, except on one
of the content icons in the center and start typing.
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° Click to add text

Non-Text Content Icons




Text Only Box

This is not a default content box available in PowerPoint, but you can create it using Slide
Master, if required. This is also indicated by "Click to add text". The only difference

between the Text Only Box and the Content Box is that the former only supports text
in the content area.
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7. PowerPoint 2010 — Adding New Text Boxes

This chapter will teach you how to add new text boxes in a slide. Most of the standard
layouts come with the text box option. As mentioned in the previous chapter, text boxes
will have "Click to add text" as the default text. Here are the steps to add new text boxes
in slide.

Step 1: Click on the Text Box icon in the Home ribbon under the Drawing section.
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Step 2: You will get the insert text box cursor that looks like an inverted cross.

Step 3: Click to insert a text box. You can now start typing directly into the text box.

Newly Inserted Text Box
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Step 4: Alternately, you can click and drag the cursor without releasing the click to
create a text box.
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The size of the text box can be adjusted by selecting one of the edges marked by squares
or corners marked by circles.

Corners




8. PowerPoint 2010 — Deleting Existing Slide

There are times while building a slide deck, you may need to delete some slides. This can
be done easily from PowerPoint. You can delete the slides from the Normal view as well
as the Slide Sorter view. In each view, you can delete the slides in two ways.

Deleting from Normal View

Step 1: Go to the Normal view.
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PowerPoint 2010

Step 2: Right-click on the slide to be deleted and select the Delete Slide option.
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Alternately, you can select the slide and press the Delete button on your key board.
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Deleting from Slide Sorter View

Let us now understand how to deleted slides from the Slide Sorter View.

Step 1: Go to the Slide Sorter view.
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PowerPoint 2010

Step 2: Right-click on the slide to be deleted and select the Delete Slide option.
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Alternately, you can select the slide and press the Delete button on your key board.



9. PowerPoint 2010 — Rearranging Slides

Rearranging slides is important when it comes to organizing the overall presentation flow.
While it is vital that you get the right content in every slide, it is equally important that
you are able to present them in a format that makes it easier for the audience to
understand the content too; most times this will require rearranging the slides.

You can rearrange slides from two views in PowerPoint - Normal View and Slide Sorter
View. Given below are the steps to rearrange slides from different views.

Normal View

Step 1: Select the slide to be moved

Step 2: Left click on the slide and drag it to the position in the sequence where you want
to placeit. PowerPoint will indicate the insert position with a line in-between existing slides.
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Step 3: When you

get to the right position release the left click button to insert the slide.

Alternately you can also cut the selected slide and paste it back in the sequence as shown

below.
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Slide Sorter View

Let us now understand how the Slide Sorter View works.
Step 1: Select the slide to be moved.

Step 2: Left click on the slide and drag it to the position in the sequence where you want
to place it. PowerPoint will indicate the insert position with a line in-between existing slides.

Clipboard 7% | Slides Font = l Paragraph

Insert Position Selected slide

Step 3: When you get to the right position, release the left click button to insert the slide

Alternately you can also cut the selected slide and paste it back in the sequence as shown
below.
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